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RELEASE NOTES - AVIZO 9.0 BETA, SEPTEMBER 2014  

Avizo 9.0 Beta 

3D Analysis Software for Scientific and Industrial Data 
 

Dear Avizo User, 

With this document we would like to inform you about the most important new features, 
improvements, and changes in this version. Please read these Release Notes carefully. 
We would appreciate your feedback regarding this version. If you encounter problems, but also if you 
have suggestions for improvement, please report them to vsghotline@fei.com. 
We would like to thank you in advance for your efforts. 

September 2014, the Avizo and Amira team 
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OVERVIEW 

Avizo 9.0 is a major evolution of the Avizo product family including new extensions, enhancements of the user 

interface for ease of use and simplified workflows, new and enhanced features, and performance improvements. 

 

 
Important note: the Avizo product family evolves!  
 
The Avizo product family is aimed primarily at providing software tools to scientists for characterizing material 
structures and properties. Thus, the previously named Avizo Fire edition has become the more widely used version, 
and more especially its image processing, analysis and quantification module, which is an essential part of Avizo’s 
feature-set for materials characterization. 
 
In order to present more clearly Avizo as the reference software for visualization, analysis, and quantification in 
Materials Science and Industrial Inspection, Avizo Fire edition will be just named Avizo. 
 
Avizo Standard edition will be called Avizo Lite as it does not include the quantification module, and hence offers 
more limited capabilities. 
 
The previous Avizo editions targeting secondary applications will become Avizo extensions, providing specialized 
features for CAE post-processing, and environmental and geophysics data visualization and analysis.  
  
Avizo Wind edition becomes the XWind extension, available for Avizo Lite and Avizo.  
The XWind extension includes dedicated visualization and computation modules, readers and writers for advanced 
FEA/CFD data processing, analysis and export. 
 
Avizo Earth edition becomes the XEarth extension, available for Avizo Lite and Avizo.  
The XEarth extension includes dedicated visualization and computation modules and workflows, as well as a SEG-Y 
reader, for the exploration and analysis of geophysics data.  
 
Avizo Green edition becomes the XGreen extension, available for Avizo Lite and Avizo.  
The XGreen extension includes visualization and computation modules, a set of geographical projections and a NetCDF 
reader, dedicated to the analysis of climate, oceanography, environmental, and earth-mapped data. 
 
 

 

About Avizo and Amira 

Avizo is 3D data visualization and analysis software dedicated to materials science and industrial inspection. Avizo 

originates from the Amira software that was initially created for scientific visualization and life sciences imaging 

applications. Amira and Avizo share the same platform and have many common features. However Amira remains 

focused on medical and biology fields, while Avizo addresses materials and physical science and industrial inspection. 
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NEW XFIBER EXTENSION 

Avizo XFiber is a new extension that provides specific support for analyzing fibers, filaments, tunnels, and other 

networks or tree-like structures. This option assists segmentation and analysis with automatic, semi-automatic, and 

interactive tools. 

NEW FILAMENT EDITOR 

The Avizo XFiber extension introduces the Filament Editor workroom (see Avizo Lite dedicated paragraph below to 

learn more about the workroom concept).  

The Filament Editor is a well proven feature of Amira that was initially designed to analyze and quantify 3D images of 

filamentous structures such as neurons and blood vessel networks. The Avizo XFiber extension now brings to Avizo 

users the benefits of the Filament Editor for the study of fiber structures in materials such as reinforced concrete, 

composite materials, paper, and so on. 

The Filament Editor offers automatic and interactive tracing tools for segmenting the centerline of the fibers and 

measuring their thickness in fiber networks and other filamentous structures, and editing spatial graphs obtained by 

skeletonization. Automatic tools can be conveniently used for images with good object-to-background contrast and 

will quickly arrive at the desired analysis. Usually, however, images suffer from degradations such as noise and blur so 

that an automatically traced image will be left with false connectivity and/or missing segments. Interactive tracing 

tools as well as a full-featured line editor can then be used to correct possible tracing errors.  

The Filament Editor is activated by pressing the Filament Editor button in the workroom toolbar.  

 

This will change the layout of the main and viewer windows.  

 

 

 



 

5 
Avizo 9.0 Beta release notes – FEI© 2014 

The main components of this layout are the following: 

 Data Selector: In the upper part of the main window two drop-down menus allow you to select the image 

and the Spatial Graph data object to be edited.  

 2D Viewer Settings: Controls for window level and thickness settings in 2D slice and 2D segment viewer. It 

also provides buttons to turn on/off volume rendering and/or slicing in the 3D viewer.  

 Label Window: The major part of the main control panel is occupied by the label window presenting a tree-

like representation of the graph. Here the user may define and edit an arbitrary number of labels on different 

hierarchical levels of the graph data. 

 Tool Box: Below the label window a tool box provides access for the tracing tools and the graph display and 

edition options. 

 Info Area: At the bottom of the control panel a box informs the user about the graph being edited.  

 Viewers: The Filament Editor typically offers three viewers for editing and viewing the data. The 2D slice 

viewer displays the image data as an arbitrarily oriented slice with variable thickness. In contrast the 2D 

segment viewer displays the image data along the currently selected segment as a curved slice also with 

variable thickness. The 3D viewer is the familiar Avizo viewer for 3D visualization of the graph data with 

optional 3D slice and volume rendering display. 

To learn more about the Filament Editor, please refer to Avizo User’s Guide. 

 

NEW FIBER TRACING FEATURES 

The Avizo XFiber extension introduces two new modules for tube-like structure detection and tracing in various 

modality acquisitions such as X-ray microtomography. These modules can be very powerful in a number of cases to 

enhance fibers or tube-like structures in noisy or low resolution images. The new modules Cylinder Correlation and 

Trace Correlation Lines are part of the new Fiber Tracing category.  

A dedicated tutorial describes the detection workflow for the example of steel fibers in reinforced concrete. 

NEW CYLINDER CORRELATION MODULE 

This module calculates the cross correlation of an input scalar field with a parametric hollow or solid cylinder with 

optional correction for missing wedge artifacts. It can be used to enhance tube-like structures in an image, for 

example cellulose fibers in paper. The module is the first step before tracing the centerlines of these structures with 

the Trace Correlation Lines module. 

NEW TRACE CORRELATION LINES MODULE  

This module traces lines based on a correlation field and an orientation field as computed by the Cylinder Correlation 

module. The output is a Spatial Graph object containing the traced centerlines. To get basic statistics for the 

generated lines, you can use the Spatial Graph Statistics module that has been enhanced to compute also the 

orientation of each centerline. 

file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/hxspatialgraph/HxSpatialGraph.html%23A1
file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/hxspatialgraph/HxSpatialGraphStats.html
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Steel fiber centerlines extracted from an X-ray microtomography scan of reinforced concrete 

 

NEW XWIND EXTENSION – ADVANCED CFD/FEA DATA EXTENSION 

Avizo Wind edition becomes the XWind extension, available for Avizo Lite and Avizo.  

The XWind extension includes all features previously available in Avizo Wind edition: dedicated visualization and 

computation modules, readers and writers for advanced FEA/CFD data processing, analysis and export. 

Like Avizo Wind edition previously, the XWind extension requires a specific license. When installing Avizo, a specific 

action is no longer required for installing the XWind extension. You simply have to enter the appropriate activation 

code to activate and be able to use the extension features. 

XWind tree view is available from the Main panel shortcuts menu: 

 

The standard behavior of the tree view in Avizo Wind that consists of organizing display, compute, and data objects in 

separate folders, can be restored by enabling the Project View option Group by display/compute/data in tree view in 

the Layout panel of the Preferences. The Models directory has been renamed to Data. 

 

NEW XEARTH EXTENSION – GEOPHYSICS EXTENSION 

Avizo Earth edition becomes the XEarth extension, available for Avizo Lite and Avizo.  

The XEarth extension includes dedicated visualization and computation modules and workflows, as well as a SEG-Y 

reader, for the exploration and analysis of geosciences data.  

Like Avizo Earth edition previously, the XEarth extension requires a specific license. When installing Avizo, a specific 

action is no longer required for installing the XEarth extension. You simply have to enter the appropriate activation 

code in the License Manager dialog. 
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A Geophysics profile has been defined to enable all XEarth extension features, which are not available in the default 

profile. To switch to the Geophysics profile, open the General panel of the Preferences and check the corresponding 

checkbox in the Current profile section. 

   

You will then be notified that Avizo must be restarted. After restart you will notice changes in the user interface, 

especially with the dedicated tree view. The profile name is shown in the Avizo title bar. SEG-Y import is now available, 

as well as dedicated modules, colormaps, etc. 

 

 

NEW XGREEN EXTENSION – CLIMATOLOGY EXTENSION 

Avizo Green edition becomes the XGreen extension, available for Avizo Lite and Avizo.  

The XGreen extension encompasses visualization and computation modules, a set of geographical projections and a 

NetCDF reader, dedicated to the analysis of climate, oceanography, environmental, and earth-mapped data. 

Like Avizo Green edition previously, the XGreen extension requires a specific license. When installing Avizo, a specific 

action is no longer required for installing the XGreen extension. You simply have to enter the appropriate activation 

code in the License Manager dialog. 



 

8 
Avizo 9.0 Beta release notes – FEI© 2014 

A Climatology profile has been defined to enable all XGreen extension features, which are not available in the default 

profile. To switch to the Climatology profile, open the General panel of the Preferences and check the corresponding 

checkbox in the Current profile section. 

    

You will then be notified that Avizo must be restarted. After restart the profile name will be shown in the Avizo title 

bar. NetCDF import will be available, as well as dedicated modules, colormaps, etc. 

 

AVIZO LITE AND AVIZO – ENHANCEMENTS AND NEW FEATURES 

USER INTERFACE ENHANCEMENTS 

WORKROOM CONCEPT 

The Avizo 9.0 user interface provides an easier and faster way to switch between application areas. With the user-

friendly workroom concept, several dedicated components are accessible as independent applications assembled 

together into the general Avizo platform. Each component provides its own specific interface, dedicated tools, and 

visualization options. Since switching between different components is possible through a simple toolbar, the user can 

explore and approach complex data sets using dedicated tools in the workrooms, and keep a clear overview in the 

general-purpose framework.  

The following components are currently available as workrooms: 

 Start page (called “Welcome”) 

 Project View workroom (called “Main”)  

 Animation Producer 

 Segmentation Editor 

 Filament Editor (requires XFiber extension) 

 

START PAGE 

When launching Avizo, a Start page now opens, giving you access to shortcuts to improve your user experience: 

 Recent data, recent projects, and template lists 

 Open Data, Open Project, and New Project shortcuts  

 Easy access to help pages, tutorials, webcasts… 
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 Latest news regarding Avizo product family and FEI events 

 Community links 

  

The Start page can be disabled but remains available at any time from the Workroom toolbar. 

PROJECT VIEW ENHANCEMENTS 

Avizo 9.0 Project View has undergone several enhancements to improve your user experience: 

 Scrolling is now automatic when dragging icons out of the view. 

 Switching to pan mode is now possible with the [ESC] key or by keeping the middle mouse button pressed. 

 Pressing [H] while a data or a display module is selected will hide all from the 3D viewer except for this data 

or display module. This can also be done from the Project menu or the object pop-up option menu. 

 Pressing [CTRL] while right-clicking on an object will display the list of favorite items of the object pop-up. A 

simple click on the item of your choice will create it. 
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 In the object pop-up, the option menu related to a selected object is now more visible and accessible. 

 
 The Project View, Properties area, and Workroom menu are now displayed on the left side of the 3D Viewer 

to improve accessibility and ergonomics. It is possible to switch back to the previous layout by checking 

Show panels on right-hand side from the Layout panel of the Preferences. 

 The Project View icons have been redesigned to improve readability. 

  

AUTOMATIC DISPLAY 

When adding a new data object in Avizo Project View, a basic display module is now automatically connected to it to 

offer a first preview. 

This feature can be enabled, tuned and disabled from the Auto-Display panel in the Preferences. You can choose to 

connect a display module to every data objects (including results of compute modules), or only to newly loaded data 

objects, or only to the first loaded data object. For each data type a display module is recommended by default.  You 

can change it as you wish. Finally you can decide to tighten all display modules to the data they are connected to, 

which can save room in the Project View and increase its readability. 
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The automatic display feature can also be easily enabled and disabled from the Project View toolbar dedicated button. 

  

DOCUMENTATION IMPROVEMENTS 

A navigation bar on top of help pages makes navigation through the Avizo online documentation easier.  

 

The online documentation now only displays by default the contents relative to the licenses installed. For users who 

would like to browse all the features of the product including those locked by missing licenses, this setting can be 

changed in the General panel of the Preferences. 

 

The index generated during the first use of the documentation search tool is now kept on disk, so that it does not 

need to be rebuilt on each restart of the application, making research faster.  

In a web browser, all Avizo and Amira product family documentation can be accessed by selecting the product of your 

choice in the top left combo box. 

 



 

12 
Avizo 9.0 Beta release notes – FEI© 2014 

This requires a compatible web browser (Internet Explorer or FireFox) with cookies enabled. The web browser may ask 

for a user confirmation about script execution. 

 

 

NEW IMAGE FORMATS SUPPORTED 

ENHANCED SUPPORT FOR TIFF-BASED FORMATS 

The range of TIFF-based formats supported in Avizo has been increased. 

Image type/option Avizo 8.1 Avizo 9.0 

Tiff - multiple pages x x 

Tiff – strips x x 

Tiff – tiles  x 

Tiff – grayscale x x 

Tiff – RGB x x 

Tiff - color model YCbCr  x 

Tiff - compression LZW x x 

Tiff - compression jpeg  x 

Tiff - compression deflate  x 

Tiff - images size > 4GB  x 

Zeiss LSM x x 

Metamorph STK x x 

Olympus Fluoview  x x 

x: supported format 

 

NEW AND ENHANCED FEATURES 

NEW MOVE-SENSITIVE EASY PROBE 

A Quick Probe feature, accessible from the viewer toolbar, allows displaying the value and coordinates of a voxel using 

the mouse.  The Quick Probe button supports three modes: move-sensitive, click sensitive, and disabled. 

     

By default, the Quick Probe is move-sensitive i.e., the voxel value and coordinates under the mouse cursor are 

displayed in the progress bar. In click-sensitive mode, the value and coordinates are displayed if the [SHIFT] key is 

pressed and visualization in the viewer is clicked on with the left mouse button.  
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NEW REVERSE COLORMAP AND ALPHA CURVE OPTION 

It is now possible to easily reverse the colormap and the alpha curve in the Colormap Editor by selecting the dedicated 

option.  

 

COLORMAP PORT ENHANCEMENTS 

The Edit menu of colormap ports has been slightly reworked. Adjust range options and zoom options are gathered in 

the same submenus. The possibility to adjust the range to data histogram has been added. 

 

When the mouse hovers over the colorbar: 

 the mouse wheel can be used to zoom on the colorbar, 

 pressing on the space bar allows zooming to range and zooming to data min-max alternately. 

Left and right thumbs of the colorbar are snapped when brought close to each other. This is convenient when you 

wish to observe a single label in a label field. 

SNAPSHOT TOOL ENHANCEMENT 

An antialiasing option has been added in the snapshot tool dialog. 
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NEW “SAVE DATA AS” AND “EXPORT DATA AS” POLICY 

The Save Data As command now allows you to save data only in native file formats. A native file format is a file format 

that can save all of the data properties in Avizo. If you want to save your data in a non-native file format, you must 

now use the new dedicated item Export Data As. The file dialog will present a list of all file formats suitable for saving 

that data object, native or not. 

     

Save Data As now renames the data object in the Project View according to the saved file name. As a project keeps 

track of the new file associated with the data object, a subsequent Save [Ctrl + S] will update that file and the project 

will refer to that file when saved and reloaded. 

On the other hand, Export Data As keeps the data object name and the project unchanged. 

NEW SAVE PROJECT POLICY 

When saving a project, it is now possible to choose between two options: 

 Minimize the project size: only necessary data objects are saved to disk ; the ones that can be recomputed 

will be recomputed at project loading. This is the legacy behavior. 

 Minimize the project loading time: all the data of the project are saved to disk. This way no computation at 

project loading is necessary. 

The first time you save a project in Avizo 9.0, the Save Project policy dialog will be displayed, allowing you to choose 

the mode you prefer and to make it the default mode for subsequent projects. 

 

You can modify the default setting at any time from the Save Project section in the General panel of the Preferences. 
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With the new option Include viewer background settings you can decide to save or not the background color and 

mode in projects. This is disabled by default. 

SCRIPTING ENHANCEMENTS 

A CamelCase label is now registered for all modules, lights, and tree view items. CamelCase labels do not contain 

spaces (words are only separated by capital letters) and may be preferred for convenience when scripting. For 

example, the CamelCase label for Ortho Slice is OrthoSlice.  

For the objects mentioned above, both the GUI labels and the CamelCase labels can be used in the Console (see below 

for auto-completion) and in scripts (GUI labels are saved in saved networks but manually created scripts can use both 

labels).  

The auto-completion in the Console works like this: 

 From an empty console line, if you press the [TAB] key, the label of the selected module in the Project View is 

suggested. It will suggest the shorter of its GUI label and CamelCase label (which is often the CamelCase one). 

If you press the [TAB] key twice or more, it will add quotation marks around the CamelCase label. 

 From few letters:  

o If there is only one possible completion, or if all the suggestions lead to the same object in the 

Project View, the shorter of its GUI label and CamelCase label is enclosed in quotation marks and 

displayed. 

o If there are several possible completions, they are all displayed, mixing GUI labels and CamelCase 

labels. 

NEW LICENSING SYSTEM IMPROVEMENTS 

The reactivation of licenses is now suggested when expired licenses are found and the process automatically 

reactivates all expired licenses. 

It is now possible to use the activation system on a computer with no internet connection. The procedure to follow is 

detailed on our website and accessible from Avizo online documentation. 

Note: Avizo 8.1 introduced a new licensing system, based on on-line activation. Please refer to Avizo 8.1 Release Notes 

for all details (http://www.fei.com/software/avizo-release-notes/). 

OPEN INVENTOR UPGRADE 

Avizo now uses Open Inventor 9.4 as its graphics engine. This upgrade includes bug fixes and improvements such as 

better performance with Delayed transparencies, a new high-performance high quality algorithm for the Sorted Layers 

transparencies, and enhanced Volume Rendering performance for texture generation (non-LDM and compressed 

volumes). 

 

NEW MODULE VOLREN AND COMPARISON WITH VOLUME RENDERING MODULE 

The new Volren module displays a direct full-resolution volume rendering of 3D images with shading effects. Volren 

enables you to render segmented regions at the same time with different colormaps. The Volume Rendering module 

has been developed to take advantage of modern graphics hardware, Volren may provide better performance than 

the Volume Rendering module on old generation graphics hardware.  

http://www.fei.com/software/avizo-release-notes/
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Differences between modules Volren and Volume Rendering 

Feature Volren module Volume Rendering module 

Mouse picking No Yes 

Isosurface Rendering No Yes  
Separate module 

Voxelized Rendering No Yes  
Separate module   

DRR rendering  
(simulated Digitally Reconstructed 
Radiograph) 

Yes No 

MIP rendering  
(Maximum Intensity Projection) 

Yes Yes 

Lighting  and shade effects Yes 
Diffuse, specular 

Yes 
Diffuse, specular, enhanced edge, 
boundary, ambient, deferred, high 

quality 

User defined light coefficients  Yes No 

Light angle control Yes 
Port Shading: User-defined 

Yes 
Use top menu View>Light 
to Create custom light and 

deactivate Headlight 

Cast shadows  No Yes 

Multi-Channel Field input No Yes 

Color Field input (RGBA) Yes Yes 

Label field secondary input and 
per-label colormap  

Yes No 

Label colormap support  
(cycling, no interpolation) 

No Yes 

Multi-Volume support Yes Yes 

Support for data larger than graphics 
memory 

Yes 
Full resolution when still, low 
resolution during  interaction 

Yes 
Progressive adaptive resolution, 

limited by memory threshold 

Support for data larger than the main 
memory (RAM) 

No Yes 
With converting data into LDA 

format 

LDA format support   
(Large Data Access for progressive loading, 
instant preview, quick extract from out-of-
core  data) 

No Yes 

ROI Box (Region of Interest) Yes Yes 

Custom ROI Yes 
Corner Cut  

exclusion corner 

Yes 
ROI Box for Volume Rendering: 

exclusion box, fence, cross, 
subvolume 

Hardware support Modern graphics boards with 
updated driver e.g. NVidia 

Quadro 

Modern graphics boards with 
updated driver e.g. NVidia Quadro 

Requires support for advanced 
shaders 
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NEW MODULES 

POINT CLOUD FILTER filters a connected Point Cloud by an expression built from the coordinates and data values of 

each Point Cloud (new name for Cluster objects). 

CORNER CUT defines a cutting region with the shape of an axis-aligned 3D box originating from a corner of the 

bounding box. The cutting box can be used to clip the volume displayed by the Volren module. 

EIGENVECTOR TO COLOR, when connected to the first eigenvector of a tensor field and to a vector field 

representing the eigenvalues (both produced by Extract Eigenvalues), generates a color representation which 

describes by a color code the directions of the first principal direction of the tensor field. 

 

ENHANCED MODULES AND EDITORS 

The SIMPLIFICATION EDITOR algorithm has been improved in order to dramatically reduce the occurrence of 

intersections in the computed simplified surface. Topological problems such as flat triangles, flat solid angles (two 

triangles overlapping), extremely close vertices, and flat edges (two triangles sharing an edge and overlapping) are 

now handled in a better way. Normal flipping problems should be avoided in most cases.  

GENERATE SURFACE now supports 32-bit input label fields. 

ILLUMINATED STREAMLINES offers a new coloring mode DEC (Directionally Encoded Colors) that uses red, green, 

and blue primaries to encode the direction of the line segment at a given point where red, green, and blue denote the 

x, y, and z directions respectively.  

ALIGN SURFACES has a new Weights port to assign different importance to vertices of the surface to be transformed. 

ISOCONTOUR ANNOTATED SLICE is deprecated and replaced with an annotate option in Isocontour Slice display 

module. 

EMBOSSED SLICE is deprecated and replaced with an embossing option in the Slice display module. 

VOLUME EDIT now supports RGBA image inputs. It has a new Padding Value port that specifies by which data 

value(s) voxels in selected regions are replaced when cutting. For color fields a specific value can be set for each 

channel. If a color field is attached to the module this port allows the user to select if changes should affect only 

the alpha channel or all channels. 

CAPTION module, if connected to a data object, will display its name.  

 

PERFORMANCE IMPROVEMENTS 

Several compute modules and image filters have been parallelized, resulting in dramatic performance improvements 

when using multi-core processing (how many cores are used can be controlled in the Performance panel of the 

Preferences dialog): 

 Arithmetic 

 Register Images 

 Resample  

 Laplacian Zero-Crossing 

 Sobel Filter 

file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/Word/HxVolren.html%23A1
file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/Word/HxExtractEigenvalues.html%23A1
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 Adaptive Histogram Equalization in 2D only (i.e., XY planes) 

 Lanczos Filter 

 Sigmoid Intensity Remapping 

 Brightness-Contrast 

 Moments Filter 

 Gamma Correction 

Spatial Graph View tube rendering has been improved in speed and responsiveness. Changing the Tube scale factor is 

now instantaneous even for large Spatial Graph objects.  

 

LINUX SUPPORTED DISTRIBUTION 

The official Linux distribution for Avizo is Red Hat Enterprise Linux 6 64-bit. Nevertheless, Avizo is likely to work on 

other 64-bit Linux distributions if the required versions of the system libraries can be found. Technical support for 

those platforms will be limited.  

In order to add custom extensions to Avizo with Avizo XPand, you will need gcc 4.4.x on RHEL 6. 

 

AVIZO - ENHANCEMENTS AND NEW FEATURES 

Avizo Fire now becomes Avizo. 

LABEL ANALYSIS ENHANCEMENTS 

NEW STANDARD SHAPE ANALYSIS MEASURE GROUP 

A new measure group, called Standard Shape Analysis, is available from the Measures drop-down list. This group can 

be used to characterize the shape parameters of labels (such as volume, barycenter, anisotropy, covariance matrix, 

voxel face area…). 

NEW MEASURES 

New XY/3D measures have been added: 

 Majority (most represented gray level intensity inside a particle) 

 Median (median gray level intensity within a particle) 

 GreyBaryCenterZ (Z coordinate of the weighted center of gravity) 

 IntegralMeanCurvature (integral of mean curvature) 

 Anisotropy (region's deviation from a spherical shape) 

 BorderVoxelCount (sum of voxels that are at the intersection of the image volume with its bounding box) 

 EigenVal1, EigenVal2 (largest and medium eigenvalues of the covariance matrix) 

 EigenVec1X, EigenVec1Y, EigenVec2X, EigenVec2Y (X and Y coordinates of the eigenvectors of the covariance 

matrix) 

 Elongation (ratio of the medium and the largest eigenvalue of the covariance matrix) 

 ExtentMin1, ExtentMin2, ExtentMax1, ExtentMax2 (extent of the data in the direction of the eigenvectors of 

the covariance matrix) 
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New 3D-only measures have been added: 

 EigenVal3 (smallest eigenvalues of the covariance matrix) 

 EigenVec3X, EigenVec3Y, EigenVec3Z, EigenVec1Z, EigenVec2Z (X, Y, Z coordinates of the smallest eigenvector 

of the covariance matrix and Z coordinates of the other eigenvectors) 

 Flatness (ratio of the smallest and medium eigenvalues of the covariance matrix) 

 VoxelFaceArea (sum of voxel surfaces that are on the outside of each connected component) 

 

NEW MODULES 

LOCAL THRESHOLDING provides algorithms to perform a binary segmentation of an image stack into foreground 

and background objects. The output of the module is a label field. The algorithms work best if multiple small objects 

need to be segmented before a slowly varying background. Local methods adapt the threshold value on each pixel to 

the local image characteristics, as opposed to global (histogram-based) methods (e.g., in Auto Thresholding and 

Interactive Threshold modules). 

BLOCK FACE CORRECTION can be used to correct inter-slice intensity variations that are typically found in block face 

scanning stacks. Using the Segmentation Editor, the user defines regions of foreground and (optionally) background 

voxels on each slice. Block Face Correction generates corrected slices that have been calculated using the mean voxel 

intensity in the labeled regions. 

FILTER BY SPREADSHEET creates a new a label field object from an existing label field, filtered by a spreadsheet. This 

feature is useful, for example, when the spreadsheet output of Shape Analysis is being filtered or as a complement for 

the Analysis Filter. 

AVERAGE VOLUME  computes the per-voxel average of an arbitrary number of 3D image data sets or label fields. 

HIERARCHICAL WATERSHED uses a variant of the watershed transform to segment gray value images into 

meaningful regions. Hierarchical Watershed can also be used to separate objects in a binary segmented image. Rather 

than producing a single segmentation, the algorithm creates a hierarchy of catchment basins so that the user can 

control the level of granularity of the labeled image. However, unlike Marker-Based Watershed, the markers are set to 

local minima and cannot be specified. 

SPREADSHEET TO POINT CLOUD converts a spreadsheet with x, y, z coordinate columns into a Point Cloud object 

(new name for Cluster objects). 

POINT CLOUD DENSITY computes the local density of a Point Cloud. The density value is stored as a new data 

column on the result Point Cloud (new name for Cluster objects). The density is defined as the number of points per 

volume of a sphere centered at the point's location. Several algorithms for computing the density are available. 

 

SOLVED ISSUES 

Avizo 9.0 Beta already provides various enhancements and solutions to known problems. During this Beta phase, our 

team will focus on solving as many issues as possible to make your experience of Avizo 9.0 as satisfactory as possible. 

In this purpose, we would appreciate your feedback regarding this Beta version. If you encounter problems, or also if 

you have suggestions for improvement, please report them to vsghotline@fei.com. 
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